
Browser Button
Browse Button

Displaying Topics
Open the View pulldown menu.
Select Show Browse Links to list the topics in a browse sequence.
Select Show Hot Links to list the topics that the current jumps to.
Select Show Popup Links to list the topics that appear in popup.

To Choose the Display Options
Click on a closed book icon with a + sign. The Help Browse window displays the list of linked 
topics beneath the selected topic. Only those topics that correspond to the type of links that you 
selected in the View menu are displayed.
You can continue to click on topics to expand the display beneath the originally selected topic or
to expand the display of other topics.

To change the Topic Displayed in the WinHelp Window
Double-click on the text of the topic title you want to read. (Do not double-click the book icon.)

To Collapse the Display of Linked Topics.
Click on a closed book icon without a + sign if there is a tree of topics displayed beneath it. The 
tree and all its branches close.

To Close All Branches Except the One Containing the Current Topic
Choose the View-Tidy command.

To Display Orphan Topics
Orphan topics do not have a specific link within the help file. They are generally accessed 
through a program menu or the F1 key during operation. Choose the View-Show Orphans 
command
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Find Text Button
Find Button

To Start the Search
Choose the Find Text Button. The Help Browser dialog box appears.

In the Search for field, type the word or phrase you want to find. Or select a previous entry from 
the drop-down list box.

Select the Topic Titles Only option to search for the text string in topic titles; select the All Text 
option to search for the string in both topic titles and text.

Check the Whole Word Only box to find complete words. For example, if you check this box and
enter the string 'man', Find Text locates only man. If you clear this box, it locates man, woman, 
manual, salamander, and so forth.

Check the Case box to find text that exactly matches the case of the text string you entered. For
example, if you check this box and enter the string man, Find Text locates man but not Man.

Choose the Search button. The Searching... status window appears and displays the progress 
of the search, including the total number of topics in which the text string is located. You can use
other applications while Find Text conducts the search.

To Cancel the Search
You can cancel the search at any time by choosing the Cancel button in the Searching... status 
window. Find Text retains all information accumulated to this point and displays the information 
in the Search Results dialog box.

To View the Results of the Search
Find Text displays the Search Results dialog box when it has completed the search or when you
choose the Cancel button in the Searching... status window. If Find Text could not locate the text
string, it displays an appropriate message.

The Topics Found list in the Search Results dialog box displays the number of matches if the 
search word or phrase found in the title and text of a particular topic. The list is sorted with the 
highest number of matches at the top; topics that have the same number of matches are in 
alphabetical order.

To Preview the Occurrences of the Text String
You can display a preview of the topic text in which the text string was found in the Topic Text 
box of the Search Results dialog box. This topic text appears in plain text without any formatting
or styles applied.

Click on a topic title in the Topic Found list. The topic title is highlighted and the topic text 
appears in the Topic Text box, at the location of the first occurrence of the search text string. The
text string is highlighted.

If there are other occurrences of the search text string in this topic, click on the Next button to 
display and highlight the next occurrence in this topic.



Click on the Previous button to view a previously displayed occurrence of the text string in this 
topic.

TO Display a Topic in the Help File's Window
You can display the topic containing the search text string in the help file's window.

In the Topics Found list of the Search Results dialog box, select the topic you want to display.

Choose the Goto Topic button. The dialog box disappears and the selected topic appears in the 
main window of the help file.

To Print a Topic from the Search Results Dialog Box.
You can print the topic containing the search text string. You cannot print multiple topics from 
the Search Results dialog box.

In the Topics. Found list of the Search Results dialog box., select the topic you want to print.

Choose the Print Topic button. The dialog box disappears and the selected topic is sent to the 
printer.



How to get the most out of this tutorial.
This tutorial is for those who like to learn new material by doing it rather than just reading about 
it. Alternatively, the on-line help serves as an excellent reference and detailed guide.

There are several ways you could use this tutorial. You could run both this tutorial and the 
program at the same time, and use Alt+Tab to switch between the two. Or you could run the 
tutorial and the program side-by-side, if your system's screen resolution is high enough to make 
this comfortable. Or you could print one or more lessons and follow along from the printout.

Step through each lesson of this tutorial to examine specific features. The tutorial will guide you 
through the design process of creating a form while introducing additional features and methods
that are related to the current task. Alternate procedures are suggested for some situations.

When you've completed the tutorial, you will have created a form with data entry fields using 
many of the design tools, features and methods available to the designer.

See Also

Browser Button
Printing from the Browser window
Find Text Button



Lesson 1     Setting up a New form

Step One
Start the program by double-clicking the program icon in the Windows program group.

Step Two

Click on the left most Toolbar button  and click the OK button in the New Form Layout dialog 
box to open a new blank form.

Step Three
Notice that the program's pulldown menu has some additional selections and there is a second 
toolbar in the form window that relate to specific form design features. The default Grid setting is
0.25" x 0.25" and this will be fine for now.

Step Four
Be sure to increase the size of the program window by clicking over the Maximize button 
located at the upper-right of the program window.

Step Five
 Also, increase the size of the form window by clicking over the Maximize button located at the 
upper-right of the form window.



Lesson 10      Duplicating Text Blocks

Step One
Click over the Text toolbar button icon and create a text block the same size as the square 
starting at grid position 0.25 x 0.50 and enter the label - Auto #1.

Step Two
With the mouse cursor on the text block press the right mouse button to popup the object menu 
and select the Text menu choice.

Step Three
This menu is the same as the Form pulldown menu, just easier to get to. In the Text dialog box 
(on the left side) set Center justification by clicking over the word Center then the OK button.

Step Four

Choose the Select toolbar button  to come out of text draw mode.

Step Five
Duplicate the text block to the last line with Ctrl+C/Ctrl+V/Shift+Arrow Down and edit each, 
entering additional weekly/monthly expenses like Auto #2, Groceries, Phone, Gas Utility, 
Electric, Cable TV, House payment or Rent, etc.

Step Six
When completed click on the text block containing Auto #1 and press Ctrl+C, then Ctrl+V to 
create a duplicate.

Step Seven
While holding the Shift key down press arrow-up once followed by arrow-right five times.

Step Eight
Move the mouse cursor over the right-center handle and press the left mouse button while 
dragging it inward to the second vertical line.

Step Nine
Double-click the text block to replace the word Auto #1 with the abbreviation Sun for Sunday.

Step Ten
Using Ctrl+C/Ctrl+V/Shift+(Arrow Right 3 times) fill the top row with six more text blocks, then 
edit them so that each column has abbreviations for each day of the week.

Step Eleven

Select the Save toolbar button 



Lesson 11      Field Objects

Step One

Select the Field toolbar button  and create a field starting at grid position 1.50 x 0.50 under 
the label Sun and to the right of Auto #1.

Step Two
Click the right mouse button over the field and select Text to change the attribute for the field to 
right justification.

Step Three
Duplicate the field across the form under each day column, then highlight the field under Sun.

Step Four
Duplicate the field placing it in the second row and then do as you did in the first row by making 
identical fields across for that row.

Step Five
The field numbers will be in sets that are multiples of seven. Row one will be field001 through 
field007 and row two will be field008 through field014 and so on.

Step Six
Duplicate all the other columns for each of the rows you created.
TIP:      Multiple Object Selection:
Normally, mouse clicking on an object will select it and deselect the previously selected object if 
there was 
one. Holding down the Shift key during object selection will prevent deselection of other objects.
This allows 
the selection of more than one object at a time. This group of objects can be moved, cut, 
copied, or pasted, 
very much like what can be done with singularly selected objects.

Step Seven

Select the Save toolbar button 



Lesson 12      Duplicating Fields

Step One
On the top row just right of the column label Sat, add another label as Item Total for the header 
of the last wider column.

Step Two
Right mouse click the text block and select Text to set a Center justification.

Step Three
Create a field under Item Total using the Field toolbar button in the form window and right 
mouse click over it.

Step Four
Select Text and set the justification to Right.

Step Seven
Duplicate the field down the column.

Step Eight

Select the Save toolbar button 



Lesson 13      Protecting a Master Form

Step One
In the Edit pulldown menu select Fill Out and enter the filename WKLY-EXP.FOM and hit the 
Enter key. The program will automatically add the FOF extension to a fillout form if you do not 
provide it.

Step Two
With the form now in fillout mode, enter a single character and then back-space to erase it.

Step Three
Save the form and now you have a protected form that can only accept data entry. The design 
of the FOM form cannot be modified. Only the data that is entered into the fields can be 
modified.

Step Four
Select the pulldown menu File-Close.



Lesson 14      Managing Forms

Step One
There should now be no forms loaded. Select pulldown menu File-Fillout.

Step Two
The cursor will be in the File Name: section of the dialog box. Press the right arrow key, then 
the backspace key and enter the letter M.

Step Three
Press the Enter key and a list of FOM files is displayed. Double click the WKLY-EXP.FOM file.

Step Four
As soon as it is loaded the program will ask for a unique filename that you want to give to this 
latest version of the form. Give the form a filename that relates to the week and the initials of the
person responsible for keeping the data current, such as 951015GK.FOF.

Step Five
Enter some startup data and save the form. Each time you fillout a form, give it a unique name 
by coding it according to date. serial number, page sequence, etc. in order to keep each new 
form separate. Otherwise, you will simple be overwriting the same form all the time.

Step Six
Add some more data to the form, save and close it, then open the FOF file.

Step Seven
This time when the program asks for a new name - select cancel. This is how you would view 
previously filled out forms or modify existing data in a form.

Step Eight
Use the pulldown menu File-Save As and give the form a different filename. Then make a 
couple change and this method is used in case you know you have a form that contains most of 
the information needed.



File Extensions
filename  .FRM  

Master Forms - Form design/create mode.

filename  .FOM  
Fill Out Master Forms - Protected data entry form.

filename  .FOF  
Filled Out Forms - Completed data forms.



Lesson 17      Mathdemo.FRM

Open MATHDEMO.FRM
Select the pulldown menu File-Open. In the dialog box under the section titled Directories make 
sure you are in the subdirectory named Fields under the program subdirectory. Double-click the 
filename MATHDEMO.FRM on the left side. After it is loaded into the program, printout the form 
so you can examine the dialog boxes that control field attributes while keeping focus on the 
basic design structure. This form will produce about a one-half page printout. With any master 
form open you can examine each of the control attributes for the fields in the form.

Fillout Order
The Field Ordering feature allows the designer to assign specific cursor movement through the 
form regardless of field position. Notice that the first field (at the top-left) is labeled field010. 
Though positioned top-left on the form, it is actually the tenth field created during form design. 
The field assignments are automatically created for cursor movement from top-left, to right, then
down regardless of whether the field was the first or the tenth. Fillout Order assignment is set in 
the demo form for the cursor to move to field004 (located below field001) as the second cursor 
position through the form during fillout mode. Then field005, followed by field006 and jumping 
back up to field001. Examine the pulldown menu Form-Fillout Order selection to see the order 
that the cursor will move through the form. Assigning the fillout order is done by selecting Form-
Fillout Order, highlighting the field name you want to reassign and click the Up or Down buttons.

Formulas
Basic math is shown in the first two examples with the formulas set in field003 and field006. 
Highlight field003, right-click and select Field Setup. The dialog box indicates that the field's 
Type is Numeric and its Automatic setting is Calculated. Clicking the folder Calculation tab will 
show the formula used to add field001 to field002 and place the result in the current (field003) 
field. The field Type must be set to Numeric for all fields involved when working with math 
equations. Not all formulas will be numerical. Check the list under the Functions section. We'll 
examine field009 later. For now cancel this dialog box.

Pick Lists
Right-click over the field labeled field007 and select Field Setup. Notice that the field is a 
Character Type and no Automatic features are set. Click the Pick List tab to see the list a items 
available for user selection into a field. Clicking the Test button will show the display that is 
presented to the user during data entry. Place the mouse cursor over the window's title bar, 
while holding the left mouse button down, drag the window down so that the Pick List structure 
area is visible. The user selection "Item 1" is the only part of the line that would be place in a 
field. The semi-colon (;) separates the Pick List selection from the comment. Line two is a 
comment extension to line one and note that there is a space before the semi-colon on line two. 
Use Ctrl+Enter for additional lines while in the edit window. Cancel the user display and you will 
see a gray area titled Pick List File with a Browse button. Use this feature to read from an 
external list of user selections that can be used by one or more forms. There is a 500 character 
limit available for each field's display. The external file (can be shared by other forms) must be 
stored in the same directory as the .FRM master form and/or the .FOF fillout form. You can also 
arrange the form list or the external list to be displayed in a specific order or turn on the Sort List
attribute for a display that is sorted alphabetically. Please use a .PIK file extension when saving 
external pick list files. Cancel the dialog box and we'll examine another feature.

Field Help



Right-click field008 and select Field Setup-Help tab. Click the Test button and reposition the new
popup dialog window to view the one behind it. Anything entered in the editing area in the 
window positioned behind the user display is shown. Use this feature to explain the purpose and
kind of data necessary for a field or area of the form. Use Ctrl+Enter for separate lines and 
paragraphs. There is also a feature for using a single ASCII text file for field help display with a 
single form or multiple forms. There is a 1K limit available for each field's display. The external 
file (can be shared by other forms)must be stored in the same directory as the .FRM master 
form and/or the .FOF fillout form.

IIF( ) Function
Field009 makes use of a formula function that determines whether or not a certain condition 
exists. The purpose of this formula is to check the current field for any existing data and take 
one of two actions depending on the results of the search. If the field is blank (field009=' '); 
perform the instructions contained in the first parameter (Place the following text string in this 
field: "Go For It"); otherwise, perform the instructions contained in the second parameter 
(Place/Keep the data that is currently contained in the following field name:    field009). The last 
parameter could be any field name on the form.

Auto-Number
An external file containing a starting number for an incremented sequence must exist (usually 
stored in the same subdirectory) for this feature to operate properly. Right-click the field and 
select Field Setup. In the Options tab (default) the field's Type is Numeric and the Automatic 
section should indicate Number. The section titled Field usually will need the "Leading Zero 
Suppression" toggled on and the "Digits after decimal pt." set to 0 (zero). The filename 
containing the starting number for the sequence must be indicated in the Automatic Number File
section. If no file name is provide during form design, the default filename is autonum.num in the
current subdirectory. There is a 1K limit available for each field's display. The external file (can 
be shared by other forms) must be stored in the same directory as the .FRM master form and/or
the .FOF fillout form. Please use a .NUM file extension when saving external auto-number files.

UPPER( ) Function
Generate data entry in a uniform appearance (ALL CAPS in this case) for all forms even if 
several people enter data on the same computer throughout the day. Other text related 
functions you may want to consider are LOWER( ), PROPER( ), LTRIM( ), RTRIM( ) and 
INSTR( ) as well as some of the conversion functions like the Date-TO-String function.

Auto-Date
Places today's Date, if set correctly, as reported by your computer's internal clock system. No 
need to be concerned about trying to remember the date.

Auto-Time
Places the current Time, If set correctly, as reported by your computer's internal clock system ... 
seems like now would be a good time to take a break.



Lesson 18    Expense1.FRM

Open EXPENSE1.FRM
Select the pulldown menu File-Open. In the dialog box under the section titled Directories make 
sure you are in the subdirectory named Fields under the program subdirectory. Double-click the 
filename EXPENSE1.FRM. After it is loaded into the program, print the form (1 page) so you 
can examine the dialog boxes that control field attributes while keeping focus on the basic 
design structure. This form will produce a one page printout. Any type of Jet printer (DeskJet, 
BubbleJet, InkJet) is restricted by a blank section at the bottom of each page and may print a 
few lines on a second page, or not at all. Check your printer documentation for the printable 
page area. With any master form open you can examine each of the control attributes for the 
fields in the form. You may save the form to a new filename (File-Save As)in order to retain the 
original version and modify the new form to suite your own needs.

Non-Printable Objects
You will see red and blue text blocks on the form which are used as reminder tags to indicate 
fields that have user defined Help (Ctrl+H) and user defined Pick Lists (Ctrl+L). Selecting the 
pulldown menu Form-Printable will set an object attribute of printable/non-printable. Removing 
the check mark for any object on a form will prevent the object form being printed. Any color or 
font may be used to contrast the comments. This is only one of the methods available to 
comment sections of a form for display or data entry.
Another method would be to create a single line text block the full width of form only showing 
the forms filename. Using Ctrl+Enter you could add notes concerning the form below the 
filename.Set the attribute to non-printable, and the screen will only display the filename of the 
form. The notes could be reviewed in design mode, but not in fillout mode.
Setting the printable attribute for all objects except fields produces a clear form overlay for pre-
printed forms. Simply test print with data in all fields to position each field to the proper location 
and hold the printout over the pre-printed form while holding them between you and a light 
source. You can then “micro-move” each field into place.

Field Help
Right-click the top-left field and select Field Setup-Help tab. Click the Test button and reposition 
the new popup dialog window to view the one behind it. Anything entered in the editing area in 
the window positioned behind the user display is shown. Use this feature to explain the purpose 
and/or kind of data necessary for a field or area of the form. Use Ctrl+Enter to separate lines 
and paragraphs.
You may also use a single ASCII text file for field help display with a single form or multiple 
forms. There is a 500 character limit available for each field's display. The external file (can be 
shared by other forms) uses the file extension .FHP and must be stored in the same directory as
the .FRM master form and/or the .FOF fillout form.

Validate
The fields with form header labels of Name, Dept. and Week Ending contain validation formulas.
Right-click one of the fields and select Field Setup to examine the simple formula used to 
prevent the user from leaving this field blank. The method is useful when you want to make sure
a user supplies complete information as well as the correct type. In cases where another field 
requires information to complete a calculation.

Field Type



The first row of the fields in the EXPENSE1.FRM file are set to accept only date information in 
the Field Setup-Options dialog box. You can set a field type for any field on the form. With this 
attribute set, only data of a specified type is accepted in the field. This protects the form from 
receiving data that makes no sense in a particular location. It also establishes a uniform 
structure for some data types such as Date and Time, Numbers, etc.

Formulas
In the three rows below the date fields are formulas to determine the cost of mileage according 
to a fixed amount per mile as entered by the user in field262 just below the word mileage on the 
form. The weekly mileage total is stored in a separate field on a line by itself so as not to 
confuse total miles with dollar amounts stored in the far right column. Formulas relating to these 
three rows are in the row containing field018 and field021 through field028.
Basic math is shown in the right column and bottom row of the main section with the formulas 
set in each field. Highlight a field on the right column, right-click and select Field Setup. The 
dialog box indicates that the field's Type is Numeric and its Automatic setting is Calculated. 
Clicking the Calculation tab will show the formula used to calculate the weekly entries for each 
item and place the result in the current field. The field Type must be set to Numeric for all fields 
involved when working with math equations. Not all formulas will be numerical. Check the list 
under the Functions section. The formula in field167 totals the numbers on the right column. The
Entertainment section of the form is used to itemize listings in the main section. There are no 
formulas in the Entertainment section. Formulas along the bottom of the main section are used 
to calculate the daily entries for all items and place the result in the current field.

IIF( ) Function
In the two bottom-center of the form the fields labeled field258 and field259 use an IIF( ) 
statement to determine Balance Due for either the Company or the Employee. Entries are 
calculated from the values stored in fields labeled field167, field254 and field255. Field258 will 
result in a negative number if money is owned to the company.
Field254
IIF((field252-(field254+field255))>=0,0,(field252(field254+field255)))
The formula first adds together the Advances (field254) received and the Direct Charges to 
Company (field256) and subtracts that value from Expenses (field252). If the resulting value is 
greater than or equal to zero, a zero value is placed in the field indicating that the company is 
not owed any money. If the resulting value is not greater than zero, the number is place in the 
current field (as a negative number) indicating how much is owed to the company.
Field259
IIF((field252-(field254+field256))>=0,(field252-(field254+field256)),0)
The formula first adds together the Advances (field254) received and the Direct Charges to 
Company (field256) and subtracts that value from Expenses (fireld252).    If the resulting value 
is greater than zero, the number is place in the current field indicating how much is owed to the 
employee. If the resulting value is not greater than or equal to zero, a zero value is placed in 
the field indicating that the employee is not owed any money.

In general, the IIF( ) statement looks like this:
IIF(    (expression)    ,    (if true place this in field)    ,    (if false place this in field)    )

Click on a variety of fields at random to examine their contents and attributes. You're now ready 
to go.



Lesson 2      Introductions
We will be using the Toolbars in design mode for most of the work, but occasionally we will refer 
to the pulldown menus to show the relationship between the two.

There is a popup menu available that is identical to the Form pulldown menu. This popup menu 
can be activated by moving the mouse cursor over an existing object and clicking the Right 
mouse button.

This feature eliminates the need to travel the mouse cursor to the top of the screen in order to 
modify an attribute for a highlighted object location near the bottom of your screen

Step One

Click on the Text toolbar button  and move the mouse cursor to the grid point 0.50 x 0.50 
which will be a point ¼" from the top left corner of the form.

Step Two
Notice that the status bar at the bottom indicates the grid position of the cursor location on the 
form. The default settings has the Snap-To feature activated so you only need to be near the 
grid point, not precisely on it.

Step Three
Press and hold down the left mouse button while dragging the cursor to the right until the grid 
position indicators show approximately 1.50 x 0.50 and release the the mouse button.

Step Four
At the blinking text cursor enter your first name and press the Enter key. Handles will appear 
around the text block indicating that the object has precedence or is the focus of our attention at
the moment.



Lesson 3      Modifying a text/field Object

Step One

Handles can be used to resize objects in the form. Click over the Select toolbar button  and 
move the mouse cursor over the handle located on the right-center of the square. The mouse 
cursor changes to a left-to-right double-arrow.

Step Two
While you press and hold the left mouse button over the handle, drag the cursor to the right to 
increase the length of the text object to show a Grid coordinate in the Status Bar at 4.00 x 0.50.

Step Three
Double click (left mouse button) the text block to edit the object and add your last name and 
press the Enter key.
Your Full name is now a part of the modified text block object.



Lesson 4      Duplicating Objects

To add your address below your name you have two choices.
One way is to create additional text blocks for each line.
      A fast method for this approach is to copy/paste an existing object.

Step One
While the focus (object has handles) is on the text block containing your name press the key 
combinations Ctrl+C followed by Ctrl+V.

Step Two
The pasted object is located on top of the original and needs to be positioned below. Hold the 
Shift key and press the arrow-down key once.

Step Three
Repeat the Ctrl+C/Ctrl+V/Shift+Arrow Down method a couple more times for the rest of the 
address and phone number lines.

Step Four
Double-click over the second text block and enter your street address, then press the Enter key.
Modify the text block to your address.

Step Five
Edit each text block for your address & phone information.

Info
If you decided later to reposition this information area on the form you would need to move 

each text block one at a time.
This duplication method can be used for any object on a form.



Lesson 5      A different approach
To add your address below your name you have two choices.

One way is to create additional text blocks for each line.
      A fast method for this approach is to copy/paste an existing object.

A different approach would be to create one text block containing all of the information 
from each line.

Step One
Copy/Paste the text block containing your full name and with the mouse cursor over it hold the 
left mouse button down and drag it to a position below the work you've done and release the 
mouse key.

Step Two
Select the handle on the bottom-center of the new text block and slowly drag it downward until it
seems to snap-to a larger size four times.

Step Three
Double-click the larger text block, move the editing cursor to the end of your name and press 
the key combination Ctrl+Enter.

Don't hit the Enter key by itself, yet.

Step Four
Type the street address information and press Ctrl+Enter again.

Step Five
Add the City-State-Zip on another line followed by Ctrl+Enter twice and your phone number on 
the fifth line.

Step Six
Pressing the Enter key after all of the information has been typed in will close the edit session 
for the text block.



Lesson 6      Positioning Objects

Step One
Position the mouse cursor over the large text block and hold down the left mouse button while 
dragging it to the right and up.

Step Two
Place the top of the text block along the grid points even with the first text block you made. 
Notice that each of the lines are closer together and easy to reposition on the form.

Step Three
If you wanted to reposition the set of blocks that are now on the left side of the form you would 
have to move and position each of them one at a time.

Info
Some situations will work better as smaller separate text blocks and others as a larger 

paragraph text block.



Lesson 7      Micro-move / Grid point
Any object you create can be moved to a grid point setting or positioned away from the grid 
points by using the micro-move feature.

Step One
Select the phone number text block on the left side of the form by clicking the left mouse button 
over it.

Step Two
Press only the down arrow key ten times and the object is positioned further away from the 
address section, but not located at a fixed grid coordinate.

Info
Arrow key movement alone will adjust any object by one hundredth of an inch.
Shift-Arrow key movement will adjust any object to the next grid point position if Snap-To-

Grid is ON.



Lesson 8      Multiple open forms

Step One

You can have multiple forms open at the same time. Click on the Open toolbar button  to 
select a form that is stored in the FRM subdirectory.

Step Two
In the File Open dialog box double-click over the FRM subdirectory on the right side of the 
display.

Step Three
On the left side is a listing of all the master forms stored in the directory. Double-click the first 
filename.

Step Four
Click the Open toolbar button again and open a file that begins with the letter A.

Step Five
Repeat the above steps for the first file that begin with the letters B, then C, then D.

Step Six
From the Window pulldown menu you can jump from one open form to the other. Also, clicking 
on another forms inactive visible window will set that form as the focus or active form.

Step Seven

At the top left of each form window there is a Form Control tab  that you can use to 
close the form while remaining in the program.

Step Eight
Go ahead and close all of the forms and we'll create a different one.



Lesson 9      Duplicating Lines & Saving

Step One

Start with a new blank form by selecting the new form icon  and click over the OK button.

Step Two

Maximize the form window and select the line draw icon .

Step Three
Then position the cursor at grid location 0.25 x 0.50 and hold the left mouse button down while 
dragging it all the way over to the right side of the form and release the mouse button.

Step Four
Use the copy/paste feature Ctrl+C/Ctrl+V/Shift+Arrow Down to duplicate the line until you have 
filled to the bottom of the screen display.
Each line will have a one-quarter inch space between them.

Step Five
Save the form to name “WKLY-EXP.FRM” using the File-Save As pulldown menu.

Step Six
Make a vertical line from grid point 1.50 x 0.25 down to the last horizontal line you pasted.

Step Seven
Duplicate it using Ctrl+C/Ctrl+V/Shift+(Right-Arrow 3 times) to create an addition vertical line ¾" 
apart.

Step Eight
Continue adding six more vertical lines three grid points apart to the left for a total of eight 
divider lines .

Step Nine

Now that you've created an existing file on hard drive, click on the Save toolbar button  
occasionally to save your in-progress work.



Printing from the Browser window
Printing

Printing Selected Topics in a Help File
Ensure that all the topics you want to print are visible in the Help Browser window.

Select the topics by holding down the Shift key and clicking on each topic with the left mouse 
button. A check mark appears next to the topic title of each selected topic. You can select a 
sequence of adjacent topics by dragging the mouse from the first topic to the last while holding 
down the Shift key.

Choose the Options-Print Selected Topics command.

Clearing the Print Selection
There are several methods of clearing the topics that you selected for printing.

To Clear All Selected Topics
Click anywhere in the Help Browse window without holding down the Shift key.

To Clear One or More Selected Topics
You can clear one or more topics from the print selection with out clearing all topics. Hold down 
both Shift and Control keys and click or drag with the left mouse button.

To Toggle the Print Selection State of a Topic
Hold down the Control key and click with the left mouse button. If the topic was selected for 
printing, it is now cleared. When you repeat this action for a topic, it becomes selected for 
printing again.



filename.FOF
Filled Out Forms - Completed data forms.

The file extension FOF is generated from the fill out master form and is used to identify filled out
forms capable of printing and displaying both form and data.

Modifications can be made to an existing FOF form such as repeat order/invoice forms 
containing previously saved information that require only minor data changes. Save the new 
version of the form to a different filename.

This file format is generally considered a data file or a record of transaction and should be 
duplicated and stored in a safe place.

Though all of the file formats can be printed, it is usually the protected FOM or the completed 
FOF files that are used to generate your forms. The form design capability allows for any 
currently used or needed form to be created on screen for printing and/or data entry.



filename.FOM
Fill Out Master Forms - Protected data entry form.

The file extension FOM (Fill Out Master) is used to identify fill out master forms capable of 
accepting data entry and saving the form and data to a different file format

Open a completed master form that contains at least one field object. Select Edit-Fill Out and 
assign the same filename as the master form except with the FOM extension. Enter a single 
character in the first field and then backspace to delete the character. Click over the Save button
or select pulldown menu File-Save to save a protected blank Fill-Out-Master form. Select File-
Close and use this new file as the one for data entry or as a protected display form.

All objects and their attributes are protected from modification during data entry. Modifications to
the form can only occur within the fields that were designed for data entry.

When a file with an FOM extension is opened, a dialog box immediately requests a new 
filename for a form file that will contain data that is entered into the fields. Enter the filename 
with out an extension.

Creating icons for your forms.

After you've created a few forms, you may want to launch them directly from an icon. Note that 
for the icon launch to work, the master forms must be in the ".FOM" format. See above for 
details. When the .FOM is attached to an icon, is launched (double mouse click, Start-Select, 
etc.), the program is opened (or brought to the foreground if already running) and the .FOM 
(associated with the icon selected) is the form of focus. However, before one can proceed, a 
name must be given for the resultant .FOF (Filled Out Form).

Start by creating a new Windows program group to hold your forms. The procedure needed to 
create groups and assign icons will depend upon whether your system operates standard 
Windows 3.1x from the Program Manager, from Norton Desktop, PC Tools Desktop, or Windows
95. Check the documentation concerning File-New in Windows 3.1x or 
Start-Settings-Add/Remove Program in Windows 95. When you have a group created to launch 
your forms you may want to give each icon label the same name as the form including the file 
extension. 

To launch a form from an icon you simply need to indicate the complete path, [ drive: ] \ [ path ] \
[filename ] . [ extension ], to the form. (Check the properties some of the icons in the program's 
group for an example.) Use the Browse button to select an icon for the form. In the program 
subdirectory there is a library of icons named EZX-ICON.LIB, though you can use any set of 
icons available on your system.

Examine the icon  in the program's group labeled Order_Form by highlighting the icon and
pressing Alt-Enter. You will notice that there is no EXE file indicated on the command line, only 
the full path and the name of the file to be opened. Make sure your command line is similar to 
this one by using the full path and name of the form you want to launch from the icon.



filename.FRM
Master Forms - Form design/create mode.

The file extension FRM is used to identify master forms capable of redesign or minor 
adjustment. Master forms contain a collection of all or part of the objects available to the 
designer.

Whether an object of a form is a Line, Rectangle, RoundRect, Ellipse, Text block or Field it can 
be repositioned, copied, resized, deleted, colored, shaded, bordered or set to be non-printable. 
Field formulas and attributes can be adjusted or removed.

A master form need not have field objects, used for data entry, if the form is to be used for 
display of information and disbursed among several people or used for manual data entry.

Once the design of the form is completed it is recommended that the master form be duplicated 
to a floppy disk or stored in a compressed file format for safety.






